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1 Introduction 
To facilitate data output and data presentation from MODFLOW model runs, the post 
processor “MOD-PP” has been written. This program reads MODFLOW’s binary and ASCII 
output files and writes the results into comma delimited files to be viewed in Excel. The 
program is able to: write (i) head data for user specified observation boreholes for all stress 
periods, (ii) water balances for all stress periods for all boundary conditions used in a model, 
(iii) river flow to and from the aquifer for all river cells over time, as well as for up to five 
specified river sections and for the entire river course and iv) stream leakage to and from the 
aquifer for all stream cells and for the entire stream course over time, as well as flows within 
stream cells and within the entire stream over time. The program, which is written in Visual 
Basic 6.0 can be applied to any steady-state or transient MODFLOW model and has no 
restrictions on layer, column or row numbers.  

This manual describing the post-processor is divided into 7 sections. After this introduction, 
section 2 gives an overview of how the program operates and which MODFLOW output files 
are required in the various modules of the program. Section 3 introduces the water balance 
module. The module for reading and writing groundwater head data for user-specified 
observation boreholes is described in section 4, while section 5 and 6 give information about 
running the river and stream modules. 
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2 General procedure of running the post-processor 

2.1 DATA ENTRY 
To run the post-processor on MODFLOW output files, the file MOD-PP.exe must be 
executed. The main menu screen which appears contains three menu items: “File”, 
“Calculate” and “Help”. Under the “File” menu, information on the relevant MODFLOW 
model can be entered and the post processor can be exited. Under the menu “Calculate” the 
various modules of the program can be selected. These include: the “Heads vs. time” module, 
the “Water Balance” module, the “River leakage” module and the “Stream flow and leakages” 
module. The “Help” menu gives explanations on the running of the post processor as well as 
on the various modules. In order to access the “Help” menu, the help files associated with the 
post processor have to be copied into the same directory as the post processor itself.  

In a first step, the MODFLOW output files have to be located. For this the menu item “Model 
information” is selected under the main menu “File” (Figure 1). Select the appropriate path to 
the model data and give the name of the MODFLOW root file without the extension. Then the 
numbers of columns, rows and layers of the MODFLOW model have to be entered. By 
clicking OK, the “Model information” window closes and the input data is loaded into all the 
modules in the program.  

 
Figure 1 Specification of file directories and model information  

The program does not check if the numbers of columns, rows and layers corresponds to the 
MODFLOW model data and hence care is required when inputting these parameter values.  
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2.2 REQUIRED MODFLOW FILES 
Depending on how many modules of the post-processor are being run, up to eight 
MODFLOW output files are required:  

(i) MODFLOW output control file (extension .oc) 

Required for all modules. 

(ii) MODFLOW output file (extension .out) 

Required for the “Water Balance” module 

(iii) MODFLOW cell-by-cell head-save file (extension .hds) 

Required for the “Head vs. time” module 

(iv) MODFLOW cell-by-cell river flow file (extension .crv) and the MODFLOW river 
location file (extension .riv)   

Required for the “River leakage” module 

(v) MODFLOW cell-by-cell stream flow file (extension .cs1) and the MODFLOW stream 
location file (extension .str) 

Required for the “Stream flow and leakages” module 

MODFLOW output files differ slightly depending on the user-interface used to create them. 
The post-processor is programmed to run on GroundwaterVistas© output files. The “Water 
Balance” module as well as the “Heads vs. time” module are able to run on output files from 
other user-interfaces as well, e.g. PMWIN©. However, the structure of the stream and river 
output files differ according to user-interface used. Consequently the “River leakage” and the 
“Stream flow and leakage” module might not run if GroundwaterVistas© is not used to run 
MODFLOW.  

2.3 EXIT 
To exit the post-processor, the menu item “Exit” from the main menu “File” has to be 
selected. This closes the application and saves all the input data. The program recalls these 
automatically the next time the application is run.  

2.4 NOTES FOR THE USE OF THE PROGRAM ON THE BGS NETWORK 
UNDER NOVELL 

Currently (February 2004), the program will run very slowly over the BGS network, if using 
PCs converted to NOVELL. This is not the case if the program is run on local drives or on 
PCs, that have not been converted. However, this matter is being investigated and the 
program should be able to run satisfactorily via the network on PCs converted to NOVELL in 
the near future.  
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3 “Water Balance” Module 

3.1 INTRODUCTION 
The “Water Balance” module is used to extract rates and cumulative volumes of water 
entering and leaving the model over time. The data is provided for all boundary conditions 
used in the model (e.g. wells, drains, recharge etc). 

The module is called by selecting the “Water Balance” option from the main menu 
“Calculate” (Figure 2).  

 

 
Figure 2 “Water Balance” module screen 

The working directory, relevant MODFLOW output files and post-processing output files are 
displayed automatically in this module if the information in the menu option “Model 
information” was confirmed by pressing OK (see section 2). If model information is not 
entered or if the menu item is exited using “Close”, data are not transferred to the “Water 
Balance” module and file names are not displayed.  

To execute the “Water Balance” module the OK button is pressed. The computing time 
depends on the size of the MODFLOW model file but is usually a few seconds. After the data 
are written to the specified output file, the “Water Balance” window closes automatically and 
a message is displayed with file name and path of the output file.  

 4 



IR/04/028   

3.2 DATA OUTPUT FORMAT 
The water balance data for every boundary condition, for every stress period and time step is 
written to a comma delimited file. This file (prefix-out.out) can be viewed and edited in Excel. 
Figure 3 shows an example of a water balance output file, and Figure 4 displays a plot of the 
data. The output file lists cumulative volumes as well as rates for every boundary condition 
present in the model and for every stress period and time step.  

 
Figure 3 Example of a “Water Balance “ module output file (prefix-out.out).  
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Figure 4 Example of the “Water Balance “ module results 
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4 “Heads vs. time” module 

4.1 INTRODUCTION 
The groundwater heads module reads time-variant head data from the MODFLOW binary 
head file for user specified cells. The module is called by selecting the “Heads vs. time” 
option from the main menu “Calculate” (FIGURE 5).   
 

 
Figure 5 “Heads vs. time” module screen 

The working directory, relevant MODFLOW output files and post-processing output files are 
displayed automatically on the “Heads vs. time” module screen, if model information has 
previously been defined using the “Model information” module (section 2). The user then has 
to enter the name of a text file, containing information on observation boreholes for which 
head values should be read. Additionally, the number of observation boreholes must be given. 
If all data are confirmed by pressing the OK button, the program generates the output file 
prefix.head.hds. This will take a couple of seconds, depending on the size of the MODFLOW 
files. When the output file is written, the window closes and a message is displayed giving 
output file name and path.  

If the post-processor is closed using the “Exit” option under the main “File” menu, the name 
of the observation borehole file and the number of boreholes is saved and called up 
automatically the next time the program is run.  
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4.2 OBSERVATION BOREHOLE FILE 
To read head data for user specified cells over time, a text file is required, containing the 
column, row and layer number of the cells, for which head information is required. Figure 6 
displays the structure of this file (prefix.txt). It should be tab or comma delimited, with four 
data entries for every borehole: ID, layer, row, column. The observation borehole file has to 
be located within the same directory as the other MODFLOW files required by this module.  

 

 
Figure 6 Example of an observation borehole file to be used within the post-processor.  

4.3 DATA OUTPUT FORMAT 
The groundwater heads module generates a comma delimited file containing time-variant 
head data for each user specified cell (Figure 7). The ID number of the observation boreholes 
is displayed in the first row, followed in subsequent rows by the head data  

Figure 7 Output file of the groundwater heads module.  
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5 “River leakage“ module 

5.1 INTRODUCTION 
The “River leakage” module extracts flows leaving and entering the model through each river 
cell. In addition, flows are provided for up to 5 river reaches and for the sum of all river cells. 
The module is called by selecting the “River leakage” option from the main “Calculate” menu 
(Figure 8).  

 

 
Figure 8 “River leakage” module screen 

The working directory, relevant MODFLOW output files and post-processing output files are 
displayed automatically on the “River leakage” module screen, if model information has been 
defined using the “Model information” module (section 2). The program is executed by 
pressing the OK button. After the output file is written, the window closes and a message is 
displayed giving the output file name and path.  

5.2 DATA OUTPUT 
Figure 10 shows an example “River leakage” module output file (prefix.riv.lea), and Figure 
11 and Figure 12 display plots of the data.  

The output file lists flows in and out of the model through each river cell. Data are provided 
for all stress periods and time steps available within the MODFLOW binary cell-by-cell river 
file. The number of stress periods/time steps depends on the settings in the “Output control” 
menu within Groundwater Vistas (Figure 9). If the user selected the cell-by-cell flows to be 
saved every single time step, then river flows for all stress periods and times steps are 
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available. However, if for example, information is saved every four time steps, then river 
flows will be available for every fourth time step.  

 

 
Figure 9 Output control menu in Groundwater Vistas. 

In addition to the flow rates for each river cell, the post-processor calculates flow rates for 
river sections or reaches. River reaches are specified within Groundwater Vistas in its “River” 
module by assigning river cells a reach number. The “River leakage” module within the post-
processor is then able to provide the flows in and out of the model for these river reaches. Up 
to 5 reaches (reach numbers in Groundwater Vistas have to be 1 to 5) can be dealt with. If the 
model contains less than 5 river reaches, zero values will appear in the output file for all 
“missing” reaches. If the model contains more than 5 river reaches, the data for 5 reaches is 
provided, while data for any other reaches will be lumped together under “Reachrest” (Figure 
10). The flows in the reaches are baseflows, i.e. the difference between inflows into the river 
(out of the model) and outflows from the river (into the model).  

Besides river reaches, information is provided for all the river cells in the model. Total river 
outflows (into the model) and inflows (out of the model) are listed as well as the river 
baseflow, i.e. difference between inflows and outflows. Inflows and outflows are thereby 
equivalent to the data generated under the “Water Balance “ module for the river boundary 
condition.  

Figure 10 shows an example “River leakage” module output file, with column 1 to 3 giving 
information on the record number, stress period and time step number. Column 4 to column N 
(N = maximum number of river cells in model) lists the flows [L3/T] in or out of the model 
through each river cells, and columns labelled “Diff reachX” give the baseflow [L3/T] in river 
reach X. “Riff reachrest” lists the baseflow [L3/T] of all reaches with reach numbers other 
than 1 to 5. Column “Flow out (all river cells)” displays the inflow into the entire river 
through all river cells (out of the model), and “Flow in (all river cells)” gives the outflows. 
Column “Diff all river cells” lists the baseflow [L3/T] for the entire river.  
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   Flow rates [L3/T]   Flow rates for entire    Flow rates for  

for single river cells  river reaches (reach 1 to 5)   all river cells 

 

 

Figure 10 River module output file.  
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Figure 11 Flow over time at one specific river cell  

 

-25000

-20000

-15000

-10000

-5000

0

5000

10000

15000

0 200 400 600 800 1000 1200 1400

Time

Fl
ux

 [L
**

3/
T]

Total river 

Reach 2

Reach 1

 
Figure 12 Flow over time for river reaches 1 and 2 and for all river cells 
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6 “Stream flow and leakage“ module 

6.1 INTRODUCTION 
The “Stream flow and leakage” module provides leakages in and out of the model through 
stream cells, as well as actual flows within a stream. The data is provided for single stream 
cells, stream reaches and for the sum of all stream cells. The module is called by selecting the 
“Stream flow and leakage” option under the main “Calculate” menu (Figure 13).  

 
Figure 13 “Stream flow and leakage” module screen 

The working directory, relevant MODFLOW output files and post-processing output files are 
displayed automatically on the “Stream flow and leakage” module screen, if the model 
information has been defined using the “Model information” module (section 2). The program 
is executed by pressing the OK button. After the output files are written, the window closes 
and a message is displayed giving output file names and path.  

6.2 DATA OUTPUT 
The “Stream flow and leakage” module generates two output files: a file listing stream flows 
(prefixstr.flo) and a file displaying stream leakages (prefixstr.lea) into and out of the model 
over time (Figure 14 and Figure 15). 

The structure of both output files is similar to the “River leakage” module output (Figure 10). 
Data are provided for each stream cell for all stress periods and time steps available within the 
MODFLOW binary cell-by-cell stream file. The number of stress period/time step records 
available depends on the settings in the “Output control” menu within Groundwater Vistas 
(Figure 9). If the user selected the cell-by-cell flows to be saved every single time step, then 
stream flows/leakages for all stress periods/times steps are available. However, if for example 
data are saved every four time steps, then stream flows/leakages will be available for every 
fourth time step. 
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In addition to flow and leakage rates for single stream cells, the post-processor provides data 
for stream reaches in [L3/T]. Stream reaches are specified within MODFLOW in the stream 
module by giving stream cells a reach number. The “Stream flow and leakage” module within 
the post-processor is then able to provide flow within reaches as well as leakages in and out of 
stream reaches. Up to 5 reaches (reach numbers in MODFLOW have to be 1 to 5) can be dealt 
with. If the model contains less than 5 stream reaches, zero values will appear in the output 
file for all “missing” reaches. If the model contains more than 5 stream reaches, the data for 
five reaches is provided, while data for any other reaches will be lumped together under 
“Reachrest” (Figure 10). Reach leakages are stream baseflows, i.e. the difference between 
inflows into the stream reach (out of the model) and outflows from the stream reach (into the 
model).  

Besides stream reaches, data is provided for the sum of all steam cells in [L3/T].  

Figure 14 is an example of the output file “prefixstr.flo”. The first two rows give information 
on stream cell locations and stream reach and segment numbers respectively. Data are then 
divided into three sections relating to flow rates for single stream cells, flows for stream 
reaches and the flows for the sum of stream cells in the model.  

 
Flow in single   Flow in stream reaches Flow [L3/T]  

    stream cells [L3/T]   [L3/T]   for the sum of  

           all stream cells 

           

 
Figure 14  Example of a stream flow output file (prefixstr.flo) from the module “Stream flow and 
leakages” 
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In/Outflow from/into single Baseflow in stream reaches   In/Outflow stream cells [L3/T]   [L3/T]
     from/into 

all stream cells 

 

 
Figure 15 Example of a stream leakage output file (prefix.lea) from the module “Stream flow 
and leakages” 

Figure 15 is an example for the output file “prefixstr.lea”. The first two rows give information 
on stream cell locations and stream reach and segment numbers respectively. Then data are 
provided on stress period and time step numbers, followed by columns containing leakages 
into or out of individual stream cells. This is followed by baseflows for stream reaches and in 
the last three columns leakages into the model through all stream cells, leakages out of the 
model through all stream cells and the baseflow over time for the entire stream, i.e. difference 
of flow in/flow out. Leakages into and out of the model through the entire stream cells 
correspond to the water balance figures for the stream boundary condition given in the 
MODFLOW output file and “Water Balance” module output file.  
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7 Summary 
A post processor for MODFLOW has been developed in order to simplify the manipultation 
and analysis of MODFLOW model results. The program reads MODFLOW binary and 
ASCII output files and converts data stored in these into comma delimited ASCII files to be 
viewed in Excel. The program is developed using Visual Basic 6.0.  

The program is able to provide the following output: 

• Flow rates and cumulative volumes of water entering and leaving the groundwater 
model through all boundary conditions for every time step and stress period. 

• Groundwater heads for user-specified model cells (observation boreholes) for every 
time step and stress period. 

• Flows into the model and out of the model through single river cells, through river 
reaches and entire rivers for every time step and stress period. 

• Flows into the model and out of the groundwater model through single stream cells, 
stream reaches and entire streams for every time step and stress period.  

• Flows within single stream cells, stream reaches and entire streams for every time step 
and stress period.  
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